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Getting Started with NetWitness Suite

Overview

RSA NetWitness Suite is a powerful threat detection suite that enables Security Operation
Centers (SOCs) to quickly locate, prioritize, and triage threats. NetWitness Suite helps you to
isolate and remediate known threats as well as those that were previously unknown. It provides
deep insight into packets and logs that provide you with an unparalleled view into your enterprise
or business.

NetWitness Suite is more powerful than ever, but it is easier for Tier 1 Analysts to use because
it automates the process of identifying and prioritizing suspicious threats. NetWitness Suite 10.6
users can still hunt for and locate threats in the same way they have done in the past using the
Investigation view, which is still available.

Architecture

RSA NetWitness Suite is a distributed and modular system that enables highly flexible
deployment architectures that scale with the needs of the organization. NetWitness Suite allows
administrators to collect two types of data from the network infrastructure, packet data and log
data. If NetWitness Endpoint 4.4 is installed and configured, endpoint event data is also
collected. The key aspects of the architecture are:

« Distributed Data Collection. The Decoder ingests packet data while the Log Decoder
ingests log data. Decoders parse and reconstructs all collected network traffic from Layers 2
-7, or log and event data from hundreds of devices and event sources, including NetWitness
Endpoint data (if installed and configured). The Concentrator indexes metadata extracted
from network or log data and makes it available for enterprise-wide querying and real-time
analytics while also facilitating reporting and alerting. The Broker aggregates data captured
by other devices and event sources. Brokers aggregate data from configured Concentrators;
Concentrators aggregate data from Decoders. Therefore, a Broker bridges the multiple real-
time data stores held in the various Decoder/Concentrator pairs throughout the infrastructure.

o Real-time Alerting. The NetWitness Suite Event Stream Analysis (ESA) service provides
advanced stream analytics such as correlation and complex event processing at high
throughputs and low latency. It is capable of processing large volumes of disparate event data
from Concentrators. ESA uses an advanced Event Processing Language (EPL) that allows
analysts to express filtering, aggregation, joins, pattern recognition and correlation across
multiple disparate event streams. Event Stream Analysis helps to perform powerful incident
detection and alerting.

o Real-time Analytics (Automatic analysis of events) The RSA Automated Threat Detection
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functionality includes preconfigured ESA analytics modules for detecting Command and
Control traffic.

o NetWitness Server. The NetWitness Server provides Reporting, Investigation,
Administration, and other aspects of the user interface.

o Capacity. NetWitness Suite has a modular-capacity architecture enabled with direct-attached
capacity (DACs) or storage area networks (SANs), that adapts to the organization's short-
term investigation and longer-term analytic and data-retention needs.

The NetWitness Suite provides large deployment flexibility. You can design its architecture
using as many as multiple dozens of physical hosts or a single physical host, based on the
particulars of the customer's performance and security-related requirements. In addition, the
entire NetWitness Suite system has been optimized to run on virtualized infrastructure.

The System Architecture comprises these major components: Decoders, Brokers,

Concentrators, Archivers, ESA, and Warehouse Connectors. NetWitness Suite components can

be used together as a system or can be used individually.

« In a security information and event management (SIEM) implementation, the base
configuration requires these components: Log Decoder, Concentrator, Broker, Event Stream
Analysis (ESA), and the NetWitness Server.

« Ina forensics implementation, the base configuration requires these components: Decoder,
Concentrator, Broker, ESA, and Malware Analysis. The Response-Server service is also

required and is used to prioritize alerts..

The table provides a synopsis of each major component:

7 Getting Started with NetWitness Suite
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System

Description

Component

Decoder / Log o NetWitness Suite collects two types of data: packet data and log data.

Decoder o Packet data, that is, network packets, are collected using the Decoder
through the network tap or span port, which is typically determined to be

an egress point on an organization's network.

o A Log Decoder can collect four different log types - Syslog, ODBC,

Windows eventing, and flat files.

« Windows eventing refers to the Windows 2008 collection methodology
and flat files can be obtained via SFTP.

« Both types of Decoders ingest raw transactional data that is enriched,

closed out, and aggregated to other NetWitness Suite components.
o The process for ingesting and parsing transactional data is a dynamic
and open framework.
Concentrator o Provides index and query capability to NetWitness Collections.
o Can optionally forward data to ESA.
Broker « Distributes NetWitness Collection access across many Concentrators or

Archivers, making the entire NetWitness Suite enterprise appear as a

single collection.
Archiver o The Archiver service enables long-term log archiving by indexing and
compressing log data and sending it to archiving storage.

o The archiving storage is optimized for long-term data retention, and

compliance reporting.

« Archiver stores raw logs and log meta data from Log Decoders for long
term-retention, and it uses Direct-Attached Capacity (DAC) for storage.

Note: Raw packets and packet meta data are not stored in
the Archiver.
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System -

Description
Component
Event o The Event Stream Analysis service provides event stream analytics
Stream Analysis such as correlation and complex event processing at high throughputs
(ESA) and low latency. It is capable of processing large volumes of disparate

event data from Concentrators.

o ESA uses advanced Event Processing Language that allows users to
express filtering, aggregation, joins, pattern recognition, and correlation

across multiple disparate event streams.
o ESA helps to perform powerful incident detection and alerting.

o The RSA Automated Threat Detection functionality includes
preconfigured ESA analytics modules for detecting Command and
Control traffic.

Core Versus Downstream Components

In NetWitness Suite, the Core services ingest and parse data, generate metadata, and aggregate
generated metadata with the raw data. The Core services are Decoder, Log Decoder,
Concentrator, and Broker. Downstream systems use data stored on Core services for analytics;
therefore, the operations of downstream services are dependent on Core services. The
downstream systems are Archiver, ESA, Malware Analysis, Investigate, and Reporting.

Although the Core services can operate and provide a good analytics solution without the
downstream systems, the downstream components provide additional analytics. ESA provides
real-time correlation across sessions and events as well as between different types of events,
such as log and packet data. Investigate provides the ability to drill into data, examine events and
files, and reconstruct events in a safe environment. The Malware Analysis service provides
real-time, automated inspection for malicious activity in network sessions and associated files.
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Logging in to NetWitness Suite

Logging in to NetWitness Suite can vary based on your environment. Y ou may have an internal
user account or an external user account. Internal user accounts are local to the NetWitness
Suite and internal users can log in to NetWitness Suite and receive role-based permissions.
External user accounts authenticate outside of the NetWitness Suite and are mapped to
NetWitness Suite roles. If you are an external user and you cannot access NetWitness Suite or
view the information that you need, contact your System Administrator. Y our Administrator can
assign the appropriate roles to your account.
1. Use an icon provided by your Administrator, or type the following in your web browser:
https://<hostname or IP address>/login
Where <hostname or IP address> is the hostname or IP address of your NetWitness
server.

The login screen is displayed.

2. Type your username and password, and then click Login.
If your login is successful, you will be logged in to the landing page specified in your user

preferences.

If you are locked out:

If you try too many times to log in with an incorrect username or password, your account will
lock. Contact your Administrator to unlock your account.

Logging in to NetWitness Suite 10
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If you have a new account or your account is expired:

1. Inthe dialog to create a new password, enter your old password, type a new password, and
confirm it. Password format rules (as defined by your system administrator) are provided on

the left and your new password must conform to the indicated format rules.

2. Click Change Password.

If you do not have the appropriate access to NetWitness Suite:

If you are able to log in successfully, but you are not able to view the information that you need,
it is possible that you need a user role assigned to your user account. Contact your Administrator
for assistance.

Log Off NetWitness Suite

To log off from the Respond view:

1. In the main menu bar, select @

2. Inthe User Preferences, click Sign Out.

To log off from the all other views:

In the main menu bar, select @ - Sign Out.
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Changing Your Password

You can change the password that you use for NetWitness Suite authentication at any time in
your user preferences. Your Administrator defines the appropriate password strength
requirements for your NetWitness Suite password, such as minimum password length and
minimum number of uppercase, lowercase, decimal, non-Latin alphabetic, and special
characters. These requirements are then displayed when changing your password.

Note: When a Core service uses a trusted connection, you do not enter a password so no
update is required for Core service accounts.

Changing Your Password 12
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To change your password:

1. Do one of the following:
o For most views, such as Investigate, Monitor, Configure, or Admin, select & > profile.

« In the Respond view, select [ :nd in the User Preferences dialog click Change my

password.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

I Preferences Preferences
Notifications General Investigation
Jobs
Change My Password o
Password Format Requirement
0Old Password = Must be at least 8 characters

New Password

Confirm Password

Reset Password After you change your password, you will have te log back into Net\Witness.

Application Settings
Browser Time Zone UTC (GMT+00:00) hd

[ Enable Motifications
[ Show Context Menus

Apply

‘ NETWITNESS SUITE 11.0.0.0-170828005355.1.5f3abcd

2. Inthe Change My Password section, enter the password that you used to authenticate to
NetWitness Suite in the Old Password field.

3. Inthe New Password field, enter the password that you want to use for the next login.

4. In the Confirm Password field, retype the new password.

5. Click Reset Password.
You will be logged out of NetWitness Suite for the changes to take effect. The new

password becomes effective the next time you log in to NetWitness Suite.
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Identify Your Role

The roles listed here are the typical roles or functions of a Security Operations Center (SOC).
Determine the role or roles that you perform in the SOC. You can use these functions as a guide
to decide how to set up and navigate NetWitness Suite so that you can efficiently perform your
job tasks.

SOC Team SOC Manager Datgf;::?cy
(SOC Management
and Reporting)
e Manage SOC Readiness Monitor and protect privacy

and sensitive information
o Respond to Incidents

o Respond to Data Breaches

Incident Reponder Threat Hunter Content Expert System
(T1 Analyst) (T2/T3 Analyst) (Threat Intelligence) Administrator
« Respond to « Hunt for threats . Investigate new o Install and configure
Incidents ) threat intelligence equipment and
o Conduct forensic software
S ; Evaluate and create ’
« Remediate incidents ~ analysis °
new feeds « Manage user access
Recommend issues
[ ]
for remediation o Create correlation | Monitor and fine
Remediate i rules to flag tune performance
o Remecdiale 1Ssues indicators of
compromise « Backup and restore

data

o Manage storage and
archives

o Update software

o Create reports for
regulatory
compliance
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NetWitness Suite Basic Navigation

The NetWitness Suite application is divided into five main functional areas, known as views,
that are based on typical Security Operation Center (SOC) roles.

« RESPOND: This view is for Incident Responders, who can view a list of prioritized

incidents to triage. These incidents come from sources such as ESA rules, NetWitness
Endpoint, or ESA Analytics modules for Automated Threat Detection. You can also view all
of the alerts received by NetWitness Suite here.

For legacy 10.6 users, this view was known as the Incident Management view. The Alerts

List in the Respond view replaces the ESA 10.6 Alerts > Summary view.

INVESTIGATE: This view is primarily for advanced Threat Hunters, who prefer to
manually hunt for threats using NetWitness Suite metadata, event analysis, and event
reconstruction. Incident Responders also use this view to get details about events associated
with an incident being investigated. Both Threat Hunters and Incident Responders can use the

forensic event reconstruction and event analysis features in this view.

MONITOR: This view is for all users. You can view dashboards and reports on different
areas of interest depending on your user permissions. NetWitness Suite opens to this view by
default.

For legacy 10.6 users, this is the Dashboard view.

CONFIGURE: This view is for Threat Intel (content) personnel, who configure data sources
and inputs to NetWitness Suite. Threat Intel personnel use this area to download and manage
Live content. They can also create and manage incident and ESA rules.

For legacy 10.6 users, this view contains Live, Incidents > Configure, and Alerts > Configure

from the previous version.

NetWitness Suite Basic Navigation
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o ADMIN: This view is for System Administrators, who set up and maintain the overall
application.
For legacy 10.6 users, this is the Administration view less the sections added to the Configure

VIEW.

Accessing Main Views

The options that open each of the main views are listed at the top of the browser window. With
the appropriate permissions, you can access any of these views at the top of every browser
window at any time.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN () admin \’j,‘

Secondary Menus

Some views have secondary menus with additional views that you can select, which vary
according to the tasks that you can complete. The following example shows the MONITOR
menu.

Additional Options

In addition to the main views, there are additional options at the top of the browser window that
are common to the entire application.

The following table describes these common options:

NetWitness Suite Basic Navigation 16
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ﬂ Jobs

Notifications

(]

User Preferences

(f1) admin

o

User Profile

Help

Main Views

The following sections explain the main views.

In the INVESTIGATE,
MONITOR, CONFIGURE,
and ADMIN views, click
this icon to view and
manage your jobs in the Jobs
tray. Jobs are on-demand or
scheduled tasks that take
some time to complete in the
NetWitness Suite
application.

Click this icon to view
notifications from the

application.

Click this icon to view your
available user preference
options. You can manage
your user preferences and

log out of NetWitness Suite.

Click your user profile to
view the available options.
You can manage your user
preferences, change your
password, and log out of

NetWitness Suite.

Click this icon to view
NetWitness Suite help

topics.

17
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MONITOR

The MONITOR view is the classic NetWitness Suite dashboard. Monitor offers preconfigured

dashboards and reports that you can use or you can create your own.

MONITOR Menu

The MONITOR menu has the following options:

o Overview: The Overview view enables you to view and manage your dashboards. You can

select the following preconfigured dashboards:

Default

Identity

Investigation

Operations - File Analysis
Operations - Logs

Operations - Network

NetWitness Suite Basic Navigation
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o Operations - Protocol Analysis

Overview

RSA SecurlD

o Threat - Hunting
o Threat - Intrusion

o Threat - Malware Indicators

For Legacy 10.6 users, this was the Dashboard view.

o Reports: The Reports view enables you to view and manage reports relevant to your SOC

role according to your assigned permissions.

Select a Dashboard MONITOR > Overview See Setting Up a Dashboard.
Create a Dashboard MONITOR > Overview See Setting Up a Dashboard.
Manage Dashboards MONITOR > Overview See Setting Up a Dashboard.
View a Report MONITOR > Reports > View See the Reporting Guide.
Manage Reports MONITOR > Reports > See the Reporting Guide.
Manage
RESPOND

The Respond view presents analysts with a queue of incidents in severity order. When you take
an incident from the queue, you receive relevant supporting data to help you investigate the
incident. From there, you can determine the incident scope and escalate or remediate it as
appropriate.

RESPOND Menu

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN ':\Ef"-_." admin

Incidents Alerts

The RESPOND menu has the following options:

o Incidents: The Incidents List view contains a list of all incidents with basic information. The

Incident Details view provides extensive details about the incident.
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o Alerts: The Alerts List and Alert Details views provide information about all of the threat

alerts and indicators received byNetWitness Suite in one location.

o Tasks: The Tasks List view enables you to create tasks and track them to completion.

The following figure shows the Respond view - Incident List view.

The following figure shows an example of the Respond view - Incident Details view.

When using NetWitness Suite as your case management tool, you can also case manage
incidents from this view. New incidents appear at the top of the incident queue in priority order
and incidents in progress are below the new incidents.

The following figure shows a high level Respond view workflow.

NetWitness Suite Basic Navigation 20
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In the Respond view, analysts look at the prioritized list of incidents and determine which

incidents require action. They click an incident for a clear picture of the incident with supporting
details and they can investigate the incident further. Analysts can then determine how to respond

to the threat, by escalating or remediating it.

What can |

do here?

View prioritized RESPOND > Incidents (Incident List See the NetWitness Respond User

incident lists

Determine
which incidents
require action
(Triage an
incident)

Investigate the
incident

Escalate or
Remediate the

Incident

Review Alerts

view)

RESPOND > Incidents (Incident
Details view)

RESPOND > Incidents (Incident
Details view)

RESPOND > Incidents (Incident
Details view) and RESPOND >
Tasks (Tasks List view)

RESPOND > Alerts (Alerts List and

Alert Details views)

INVESTIGATE

Guide.

See the NetWitness Respond User
Guide.

See the NetWitness Respond User
Guide. (You can also pivot to the
Investigate view.)

See the NetWitness Respond User
Guide.

See the NetWitness Respond User
Guide.

The Investigate view presents three different views into a set of data, allowing analysts to see
metadata, events, and potential indicators of compromise. This figure illustrates one of the
views, the Navigate view, showing all data on a Concentrator being investigated.

21
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This is an example of the Events view.

Clicking the Event Analysis link for a specific event on the Events view opens the Event
Details view.

NetWitness Suite Basic Navigation 22
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This is an example of the Malware Analysis Summary of Events.

INVESTIGATE Menu

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN G:‘ijadmin & f:j

Navigate Events E]
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The INVESTIGATE menu has the following options:

Navigate: The Navigate view provides a toolbar for filtering and querying data along with a
view of the metadata and a timeline visualization. Analysts can drill into the data, open
selected events in the Events view, and look up additional context from the Context Hub

service.

Events view: The Events view provides a toolbar to refine the data set and a list of events.
Analysts can browse a simple list of events, a detailed list, and a log list. When an interesting

event, is found, they can safely view a reconstruction of the event and conduct event analysis.

Malware Analysis: The Malware Analysis view enables analysts to analyze certain types of
file objects to assess the likelihood that a file is malicious. Malware Analysis is an automated
malware analysis processor designed to analyze certain types of file objects (for example,
Windows PE, PDF, and MS Office) to assess the likelihood that a file is malicious. Using
Malware Analysis, the malware analyst can prioritize the massive number of files captured in

order to focus analysis efforts on the files that are most likely to be malicious.

To work in Investigate, analysts begin by running a query to select a subset of the collected data.

Analysts can browse the data in the Navigate view, create their own queries, refine the filters,
and control the way the metadata is ordered and displayed. Upon finding an event of interest,
analysts explore and inspect the event details for suspicious or malicious activity. Refer to the

Investigation and Malware Analysis User Guide for detailed information.

The following figure shows a high level workflow of the Investigate view.

NetWitness Suite Basic Navigation 24
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Query and view meta keys INVESTIGATE See "Conducting an Investigation" in the

and values found in a set of view Investigation and Malware Analysis User
data Guide.
Examine, reconstruct, and INVESTIGATE See "Examine Events" in the Investigation

) and Malware Analysis User Guide.
analyze events view

Look for file objects that may INVESTIGATE  gee "Conduct Malware Analysis" in the

contain malicious code view o )
Investigation and Malware Analysis User

Guide.

CONFIGURE

The Configure view enables Threat Intel (content) personnel to configure data sources and
inputs to NetWitness Suite in one convenient location.

CONFIGURE Menu

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN E\Eiladlﬁwin

Live Content ncident Rules Esa R

The CONFIGURE menu has the following options:

o Live Content: (Live Services) The Live Content view enables you to search for and
subscribe to Live Services resources. Live Services is the component of the NetWitness Suite
that manages communication and synchronization between NetWitness Suite services and a
library of Live content available to RSA NetWitness Suite customers. You can view, search,
deploy, and subscribe to content from the RSA Live Content Management System (CMS) to
NetWitness Suite services and software. When you subscribe to a resource, you agree to
receive updates on a regular basis from RSA Live Services.

For Legacy 10.6 users, this was Live > Search.

o Incident Rules: The Incident Rules view enables you to create aggregation rules with
various criteria to automatically create incidents. You can view prioritized incidents in the
Respond view.

For Legacy 10.6 users, this was Incidents > Configure.

25 NetWitness Suite Basic Navigation
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o ESA Rules: The ESA Rules view enables you to manage the Event Stream Analysis (ESA)
rules that specify criteria for problem behavior or threatening events in your network. When
ESA detects a threat that matches the rule criteria, it generates an alert.

You can create ESA rules yourself or download them from Live Services. The Rule Library
shows all ESA rules created or downloaded. To activate rules, you have to add them to a
deployment. Deployments map rules from your rule library to the appropriate ESA services.
For Legacy 10.6 users, this was Alerts > Configure.

o Subscriptions: (Live Services) The Subscriptions view enables you manage the Live content
that you subscribed to in the Live Content view. To set up Live Services on NetWitness Suite,
you configure the connection and synchronization between the CMS server and NetWitness
Suite.

For Legacy 10.6 users, this was Live > Configure.

o Custom Feeds: (Live Services) The Custom Feeds view streamlines the task of creating and
managing custom feeds, as well as populating the feeds to selected Decoders and Log
Decoders. You can set up and maintain custom and identity feeds.

NetWitness Suite uses feeds to create metadata based on externally defined metadata values.
A feed is a list of data that is compared to sessions as they are captured or processed. For
each match, additional metadata is created.

You can create custom feeds to provide extra metadata extraction, for example, to
accommodate custom network applications.

For Legacy 10.6 users, this was Live > Feeds.

Create a Live Services RSA Live Registration Portal: See the Live Services
account. https://cms.netwitness.com/registration/ Management Guide.
Find and deploy Live CONFIGURE > Live Content See the Live Services
Services resources. Management Guide.
Create incidents CONFIGURE > Incident Rules See the NetWitness

. Respond User Guide.
automatically.

Configure alerts. CONFIGURE > ESA Rules See the Alerting
Using ESA Guide.

NetWitness Suite Basic Navigation 26
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Set up Live Services CONFIGURE > Subscription See the Live Services
Management Guide.

Services on NetWitness

Suite

Set up and maintain custom ~ CONFIGURE > Custom Feeds See the Live Services

and identity feeds. Management Guide.
ADMIN

In the Admin view, Administrators can manage network hosts and services; monitor the health
and Wellness of NetWitness Suite; and manage system-level security. They can also configure
global system resources and manage event sources.

ADMIN Menu

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN E;Ei.[_]admin “

The ADMIN menu has the following options:

o Hosts: The Hosts view is where you set up and maintain hosts. A host is the machine on

which services run and a host can be a physical or virtual machine.

o Services: The Services view enables you to manage services, manage service users and
roles, maintain service configuration files, and explore and edit service properties. A service
performs a unique function, such as a Decoder service, which captures network data in

packet form.

o Event Sources: The Event Sources view enables you to manage event sources and configure
alerting policies for them. Organizations typically monitor event sources in groups based on
the criticality of the event sources. You can create monitoring policies for each event source

group and order them based on priority.

o Health & Wellness: The Health & Wellness view enables you to monitor the health of the

NetWitness Suite hosts and services in your network environment.

o System: The System view enables you to set global NetWitness Suite configurations. You
can configure global audit logging, email, system logging, jobs, RSA Live Services,
URL integration, Investigation, Event Stream Analysis (ESA), ESA Analytics, and advanced
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performance settings. In addition, you can manage NetWitness Suite versions and configure

the local licensing server.

o Security: The Administration Security view provides the capability to manage user accounts,
manage user roles, map external groups to NetWitness Suite roles, and modify other security-
related system parameters. These apply to the NetWitness Suite system and are used in

conjunction with the security settings for individual services.

Manage hosts. ADMIN > See the Host and
Hosts Services Getting
Started Guide.
Manage services including managing service user ADMIN > See the Host and
access and security. Services ) )
Services Getting
Started Guide.
Manage event sources and configure alerting ADMIN > See the Event
policies for them. Event Sources Source Management
Guide.
Set up and monitor alarms for the hosts and services ADMIN > See the System
Health &
in your NetWitness Suite domain. Maintenance Guide.
Wellness >
Alarm
Monitor statistics for the NetWitness Suite hosts ADMIN > See the System
and the services running on the hosts. Health & Maintenance Guide.
Wellness >
Monitoring
Create and apply policies to your hosts and services ADMIN > See the System
to help you maintain the health and wellness of your Health & Maintenance Guide.
NetWitness Suite domain. Wellness >
Policies
Set global configurations for NetWitness Suite. ADMIN > See the System
System Configuration Guide.
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Configure Global Audit Logging. ADMIN > See the System
Systen > Global  Configuration Guide.
Auditing

Set up system security. ADMIN > See the System
S " Security and User

eeurtty Management Guide.

Manage system users with roles and permissions. ADMIN > See the System

Security Security and User

Management Guide.
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Setting up Your Default View by SOC Role

After logging in to NetWitness Suite, you can make navigating the application easier by setting
up your default view based on your Security Operations (SOC) role. You set your default view,
also known as a landing page, in your user preferences.

The following figure shows the main NetWitness Suite views.

Respond: This view is for Incident Responders, who can view a list of incidents to triage and
alerts. For legacy 10.6 users, this view was known as the Incident Management view and the
Respond > Alerts view replaces the ESA 10.6 Alerts > Summary view .

Respond is the default opening view. If you do not have permission to see the Respond view,

you will have Monitor as your default view.
Investigate: This view is for Threat Hunters, who investigate and hunt for advanced threats.

Monitor: This view is for all users and it is the classic view for previous application
versions. You can view dashboards and reports on different areas of interest depending on
your user permissions. You have the option to select a preconfigured dashboard, import a

dashboard, or create your own custom dashboard.

Configure: This view is for Threat Intel (content) personnel, who configure data sources and
inputs to NetWitness Suite. Threat Intel personnel use this area to download and manage Live
content. They can also create and manage incident and ESA rules.

For legacy 10.6 users, this view was Live, Incidents > Configure, and Alerts > Configure.

Admin: This view is for System Administrators, who set up and maintain the overall

application.

You can select any of the main NetWitness Suite views as your default view. In addition to the
main views, NetWitness Suite has predefined dashboards that you can select in the Monitor
view depending on the tasks you perform:

Default Dashboard
Identity Dashboard
Operations - Logs Dashboard

Operations - Network Dashboard

Overview Dashboard
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o Threat - Indicators Dashboard

e Threat - Intrusion Dashboard

The following table shows typical SOC roles and the available views you can select as your
landing page in your user preferences based on your SOC role. If you have more than one role,
select the view that is most appropriate for you to start with when you log in to NetWitness

Suite.

SOC Roles

Role

Description

Consider this Default Landing Page

Incident
Responder
(Tier 1
Analyst)

Threat Hunter
(Tier 2/Tier 3
Analyst)

SOC Manager
(SOC

Addresses
incidents and
alerts queued
for them to
review and
mitigate

Investigates
and hunts for
advanced
threats
Manages SOC

readiness and
responds to

RESPOND

INVESTIGATE

MONITOR (Dashboard is in the MONITOR view.) When
you log in, select the appropriate predefined dashboard for

Management  incidents and your SOC role. You can also import a dashboard or create

and data breaches.  your own dashboard.)

Reporting)

Content Configures MONITOR or CONFIGURE (Dashboard is in the

Expert data sources MONITOR view. When you log in, select the appropriate

(Threat and inputs to predefined dashboard for your SOC role. You can also

Intelligence)  NetWitness import a dashboard or create your own dashboard. If you
Suite. choose MONITOR as your default view, you can navigate

to the CONFIGURE view from the main menu.)
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SOC Roles

Role

Description

Consider this Default Landing Page

Data Privacy
Officer
(DPO)

System

Administrator

Similar to an
Administrator,
but a DPO
monitors and
protects
privacy-
sensitive
information.
Focuses on the
configuration
and stability of
the overall
application.

Manages user

accCess.

MONITOR (Dashboard is in the MONITOR view. When
you log in, select the appropriate predefined dashboard for
your SOC role. You can also import a dashboard or create
your own dashboard.)

ADMIN

Setting Your Default View

1. (Respond view only) On the main menu bar, select .
The User Preferences dialog shows your current preferences.
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2. In the Default Landing Page ficld, select the default view that you would like to see when
you log in to NetWitness Suite. Use the above table to make your selection based on your
SOC role. For example, if you are an Incident Responder, you can select Respond and if
you are a Threat Hunter, you can select Investigate.

Your preferences become effective immediately. You can change your default landing page

at any time. For information on other preferences, see Setting User Preferences.

3. To verify that you can see the correct default view, click Sign Out to log out and then log
back in to NetWitness Suite.

Basic Troubleshooting Tips for User Setup

The following table provides basic troubleshooting tips that may be helpful for user setup in
NetWitness Suite.

Troubleshooting Tip

When I loginto Verify that the correct default view is set in the Default Landing Page field
NetWitness in your user preferences. If you select the MONITOR view, you can select
Suite, I see the  the predefined dashboard that is most appropriate for your SOC role. You
wrong default can also import or create your own dashboard.

view.

I see the correct Try using another browser. For example, if you are using Safari, try using
view, but the Firefox or Chrome.
metadata does

not load.

I am using NetWitness Suite supports modern (or current) versions of the latest
browsers. Try installing a newer browser version. If you cannot upgrade
your browser, you can try

10 and I getthe  enabling the TLS 1.2 protocol in your browser:

Navigate to Internet options > Advanced > Settings > Security. In
addition to your other protocols, ensure that the TLS 1.2 protocol is
enabled. Click Apply. Reload the page.

Internet Explorer

following error:
The page
can't be

displayed.
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Troubleshooting Tip

When I login, I See your Administrator, you may need a user role assigned to your account

cannot see or additional troubleshooting.

anything.

[ can't see Go to the User Preferences in the Respond view or see your Administrator.
where to change

my default

landing page.
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Setting User Preferences

You can view and manage your NetWitness Suite global application preferences from your user
profile. Your global preference options vary depending on whether you access them from the
new Respond view or other views, such as Monitor, Configure, Admin, and Investigate.

You can:

« Set the application time zone
o Set the application date and time format (Respond view only)
o Select your default starting location (Respond view only)

o Change your password (all views except Respond view) - See Changing Your Password for

more information.
o Enable or disable notifications (all views except Respond view)

« Enable or disable context menus (all views except Respond view)

View Your User Preferences (Respond view)

In the upper left corner of the NetWitness Suite browser window, select @
The User Preferences dialog shows your current preferences when accessed through the
Respond view.

Any selections that you make become effective immediately.
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View Your User Preferences (all views except Respond view)

For the following views: Investigate, Monitor, Configure, and Admin: In the upper left corner of
the NetWitness Suite browser window, select @ - profile.
The Preferences dialog shows your current preferences.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN l@‘]:—ldmin ¥
I Preferences Preferences
Notifications General || Investigation
Jobs
Change My Password X
Password Format Requirement
old Password = Must be at least 8 characters

New Password

Confirm Password

Reset Password after you change your password, you will have to log back into Netwitness,

Application Settings
Browser Time Zone UTC (GMT+00:00) v

[# Enable Notifications
[ Show Context Menus

Apply

NETWITNESS SUITE 11.0.0.0-170828005355.1.5f3a6c5

Set the Time Zone and Date and Time Format

You can change the time zone and the format of the date and time for your location.

Note: You can only change the date and time preferences for your location from the Respond
view.

1. Inthe User Preferences dialog, select your localization preferences:
a. Time Zone: Set the time zone to use in the NetWitness Suite.

b. (Respond view only) Date Format: Set the format for the order of the display of the
month (MM), day (DD), and year (YYYY). For example, the MM/DD/YYYY format
shows the date as 05/11/2017.

c. (Respond view only) Time Format: Set the time as 12-hour or 24-hour time. For
example, 2:00 PM in 12-hour time is 14:00 in 24-hour time.

Changes in the Respond view become effective immediately.

2. (All views except Respond) Click Apply.

Your preferences become effective immediately.
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Select the Default Starting Location

1. (Respond view only) Open the User Preferences dialog.

2. In the Default Landing Page ficld, select the opening view that you would like to see when
you log in to NetWitness Suite. You can choose Respond, Investigate, Monitor, Configure,
and Admin according to your user role. For example, you can choose Respond to go directly

to the relevant section of the application for Incident Responders. See Setting up Your Default

View by SOC Role to help you select the appropriate default view.

This selection sets the default view for the entire application. Changes become effective

immediately.

Enable or Disable System Notifications for Your User Account

(All views except Respond view) By default, NetWitness Suite system notifications are
enabled when a new user account is created. You can disable and enable these notifications at
any time.

1. In the Preferences dialog:
« To enable notifications for your user account, select the Enable Notifications checkbox.
o To disable notifications, clear the Enable Notifications checkbox.

2. Click Apply.

Your preference becomes effective immediately.

Enable or Disable Context Menus for Your User Account

(All views except Respond view) By default, context menus are enabled when a new user
account is created. Context menus provide additional functions for specific views when you
right-click a view.

1. In the Preferences dialog:

o To enable context menus for your user account, select the Enable Context Menus
checkbox.

o To disable context menus, clear the Enable Context Menus checkbox.

2. Click Apply.

Your preference becomes effective immediately.
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Note: Settings available on the Investigate tab in the Preferences dialog (for all views except
Respond) are documented in the Investigation and Malware Analysis User Guide.
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Managing Dashboards

A dashboard is a group of dashlets that give you the ability to view in one space, the key
snapshots of the various components that you consider important. In NetWitness Suite, you can
compose dashboards to obtain high-level information and metrics that portray the overall picture
of a NetWitness Suite deployment, displaying only the information that is most relevant to the
day-to-day operations.

By default, the NetWitness Suite default dashboard is displayed when you log in to NetWitness
Suite, and it is populated with a few useful dashlets to get you started with your own
customizations. The dashboards for all NetWitness Suite components are available to add to the
default NetWitness Suite dashboard or a custom NetWitness Suite dashboard.

You can view dashboards and reports on different areas of interest depending on your user
permissions. You have the option to select a preconfigured dashboard, import a dashboard, or
create your own custom dashboard. The dashboards help you to quickly and easily view reports.
You can configure your dashboards to display the information that supports your workflow. This
topic explains the high-level tasks that can be done when you are setting up a dashboard.

Dashboard Basics

If the Monitor view is your default landing page following logging in to NetWitness Suite you
will always see either the default dashboard or the currently configured dashboard immediately
after completing the login process. To return to the dashboard from another NetWitness Suite
component, go to Monitor > Overview.

Dashboard Title

The dashboard title reflects the currently active dashboard; for example, Default Dashboard.

Dashboard Selection List

You can access preconfigured and custom dashboards on the dashboard selection list. When you
select a dashboard, its title is displayed below the NetWitness Suite toolbar.
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' Default Dashboard ~ n

Default

Identity

Investigation

Operations - File Analysis
Operations - Logs
Operations - Metwork
Operations - Protocol Analysis
Overview

RSA SecurlD

Threat - Hunting

Threat - Intrusion

Threat - Malware Indicators

A dashboard has:
o The dashboard toolbar

o The dashboard title and the dashboard selection list.

Dashboard Toolbar

The dashboard toolbar is available next to the title of the selected dashboard. The dashboard
toolbar allows various operations on dashboards and dashlets.

Note: The Copy, Delete, Import, Export, Share, and Add Row options are disabled for
preconfigured dashboards.

oo

. Sets the selected dashboard as the Favorite.

Displays the list of available dashboards from

which you can make a selection.

. Displays the Create a Dashboard dialog, where
you define or add a custom dashboard.

Managing Dashboards 40



Getting Started Guide

G == N

Deletes a custom dashboard. The default
dashboard cannot be deleted.

|_|_:_=j Allows you to copy a dashboard.

Displays the Manage Dashlet dialog.

! Exports a dashboard as a .zip file.
! Imports a dashboard as .zip or.cfg file.

Allows you to share a dashboard with another
user.

Enables user to add rows and columns to the

dashboard based on the requirement. Click the

. icon in a row to add a dashlet.

The Default Dashboard

The default dashboard is configured to display specific dashlets in specific positions. The default
dashboard serves as an example of dashboard composition and a starting point for customization.

e You can customize the information on the default dashboard by editing, adding, moving,

maximizing, and deleting dashlets.
o After modifying the default dashboard, you can restore the default dashboard () to its
original layout.

o The default dashboard cannot be deleted or shared.

Selecting a Preconfigured Dashboard

On installation of NetWitness Suite Suite, the following preconfigured dashboards are
automatically activated and are available to you:

o Default

o Identity
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« Investigation

o Operations - File Analysis

o Operations - Logs

o Operations - Network

o Operations - Protocol Analysis
o Overview

o RSA SecurID

o Threat - Hunting

o Threat - Malware Indicators

o Threat - Intrusion

o Threat - Malware Indicators

Y ou cannot perform the following actions on a preconfigured dashboard:
o Edit a dashboard

o Export a dashboard

o Share a dashboard

o Delete a dashboard

For more information on each Preconfigured dashboard, see the Dashboards Catalog in the
RSA Content space on RSA Link.

Enabling or Disabling Dashboards

When you enable or disable a dashboard, all the dashlets within the dashboard are enabled or
disabled along with the associated charts, unless they are used in any other dashboard.

NetWitness Suite modules can display only those dashlets presented in the Manage Dashlet
dialog. The main dashboard offers all NetWitness Suite dashlets. This is an example of currently
available dashlets.
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e o

Dashboard List Displays a list of the default, preconfigured, and custom
dashboards.

¥ @ Enable Displays if the selected dashlet is enabled.

L] Disable Displays if the selected dashlet is disabled.

Title Displays the title of the selected dashlet and you can also

rename the dashaboard.
Past Hours Displays the time for which the data is collected.

Dashlet Refresh Intervals Displays the refresh interval time of a dashlet.
(Minutes)

Enabling a Dashboard

If you select a dashboard that is not enabled, a masked screen is displayed.

43 Managing Dashboards



Getting Started Guide

To enable one or more dashboard(s):

L.

Navigate to the dashboard to be enabled.

In the dashboard toolbar, click

Select the Manage Dashboard option.

The Manage Dashboards dialog is displayed.

Manage Dashboards

] O0O0O0

O oOoo-

O Dashboard List

Default

Identity

Investigation

Operations - File Analysis
Operations - Logs
Operations - Network
Operations - Protocol Ana
Overview

RSA SecurlD

W

[+ ® Enable [ Disable

Dashlet Refresh Interval (Minutes)

15

<>

Cancel Save

4. From the dashboard list, select the dashboard(s) to be enabled.
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5. Click the Enable checkbox.

6. Click Save.

Disabling a Dashboard

To disable one or more dashboard(s):

1. Navigate to the dashboard to be disabled.

2. In the dashboard toolbar, click

3. Select the Manage Dashboard option.
The Manage Dashboards dialog is displayed.

Manage Dashboards

O Dashboard List ~
[0 Enable B O Disable
O Default

Identity

X} O

Investigation
Operartions - File Analysis
Operations - Logs
Operations - Network Dashlet Refresh Interval (Minutes)

Operations - Protocol Ana 15

L4

Overview

OoOoOoooad

RSA SecurlD v

Cancel Save

4. From the dashboard list, select the dashboard(s) to be disabled.

5. Click the Disable checkbox.

6. Click Save.

Setting a Dashboard as a Favorite

To customize the views in NetWitness Suite, you can set a preconfigured or custom dashboard
as a Favorite. The NetWitness Suite dashboard, as the name suggests, offers all NetWitness
Suite dashlets. The Favorite dialog sets a specific dashboard as your favorite dashboard and will
be listed as favorite every time you log in to NetWitness Suite.

1. Navigate to any dashboard.

2. In the dashboard toolbar, click

45 Managing Dashboards



Getting Started Guide

If the favorite icon is red in color, it indicates that selected dashboard is set as a Favorite and
is listed on top above the line.

Creating Custom Dashboards

You can create custom dashboards to serve a particular purpose; for example, to represent a
specific geographical or functional area of the network. Each custom dashboard is appended to
the dashboard selection list.

To create a custom dashboard:

1. In the dashboard toolbar, click =
The Create a Dashboard dialog is displayed.

Create a Dashboard

Dashboard Title |My Dashboard

Cancel

2. Enter a title for the new dashboard and click Create.
The new dashboard is displayed as a blank screen.

3. Add rows to the dashboard, which can contain one or more columns, using the Add Row (

) control on the right side of the screen. Just click on the desired column
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configuration in the drop-down list to add one row to the dashboard with the selected number

of columns. Repeat the process to add more rows.

4. You can now add any desired dashlets to the dashboard by click the - in an empty

placeholder in a row. For complete details on adding and managing dashlets, see Working
with Dashlets.

Once custom dashboards are created, you can:

o Switch between dashboards by selecting an option from the dashboard selection list
o Delete any custom dashboard

o Import or export a dashboard

Each dashboard has:

o The dashboard toolbar

o The dashboard title and the dashboard selection list

e Zero or more dashlets

Working with Dashlets

NetWitness Suite uses dashlets to display focused subsets of system information, services, jobs,
resources, subscriptions, rules, and other information.
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The controls for a dashlet are in the title bar. All dashlets use a common set of controls, and only
those that apply to the particular dashlet appear in the title bar of the dashlet.

The following table displays the description of each icon on the dashlet.

e~ o

A Collapse  Collapses the dashlet vertically so that only the title is visible.

vertically

Expand Expands the dashlet to its original size.

<I

vertically
& Reload Reloads the dashlet.
10 Settings ~ Displays configurable settings for the dashlet.
¥ Maximize In some dashlets with content that does not fit horizontally within the
width of the dashlet, maximizes a chart or a dashlet to full screen.
X Delete Deletes the dashlet from the dashboard.
Lo Displays the time at which the data is polled from the related chart.
Refresh
ed at
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oo o

When clicked, navigates to the corresponding dashboard which is
linked to the main dashlet and displays more details. If you have not
linked the dashboard to an existing dashlet, this link with not be

View available on the dashlet. To configure this option, click @ , and in the
Dashboard Link field select a related dashboard view more details of

More the specific dashlet.

Note: This feature is only available for the realtime chart dashlet
and the preconfigured dashboards in NetWitness Suite 11.0 or later.

You can add dashlets to the default dashboard or construct a custom dashboard with your own
useful set of dashlets to make your workflow more efficient.

Add a Dashlet

To customize the views in NetWitness Suite, you can add dashlets to a default dashboard or
create custom dashboards. However, you cannot add dashlets to preconfigured dashboards.

To add a dashlet:

1. Navigate to any dashboard or create a new dashboard.
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2. Click H on the placeholder where you want to add the dashlet.
The Add a Dashlet dialog is displayed.
Add a Dashlet

Type

Cancel

3. Click on the Dashlet Type selection list to view the available dashlets, and select the type of

dashlet you want to add. Depending on the type of dashlet you are adding, some configurable

fields will be displayed in the Add a Dashlet dialog.

4. Type a title for the dashlet. The title can include letters, numbers, special characters, and

spaces.
5. If there are additional configurable fields for the dashlet, set appropriate values.

6. When all required fields have been configured, click Add.

The dashlet is added to the dashboard in the selected placeholder and is automatically saved.

Edit Dashlet Properties

All preconfigured dashlets are read-only and their properties cannot be edited. Other dashlets
are editable and allow users to customize some aspect of the data displayed in the dashlet. A

dashlet with editable properties has a settings () option that displays all the editing options.
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After the dashlets are added, you can drag and drop them and they can be swapped.

A dashlet without editable properties, such as the Live Subscriptions dashlet, does not display
the settings option in the title bar. Many dashlets have an editable title where you can edit the
following properties:

o Dashlet display title.

o Type of services to monitor; for example, you can monitor only Decoders, or you can

monitor Decoders and Concentrators.

Other dashlets have parameters that you define to specify the kind and amount of information
you want to see in the dashlet. For example, a Realtime Chart Dashlet has the settings option.

1. To display and modify the options for a dashlet, click settings (‘E}) in the dashlet title bar.
The Options dialog is displayed.

2. Edit any of the displayed properties. For example, in an Investigation Top Values dashlet,
you can edit the Result Limit from 20 to 40.

3. Click Apply.

Some dashlets have configuration options to tailor the appearance or the contents of the dashlet.

The following options are available for RE Top Alerts, RE Alert Variance, and RE Realtime

Charts dashlets on left-click:

o Hide For 24 Hours: This option allows you to hide the selected value for the next 24 hours.
After 24 hours, the data will automatically be displayed on the dashlet, if the value is
configured and listed on top.

o Hide Permanently: This option allows you to hide the selected value permanently until you
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add it back using the Manage Hidden Values option.

o Manage Hidden Values: This option displays a list of all the hidden values. You can select
the checkbox for a value and click Remove to view the data back on the chart.

Note: The options to Hide for 24 Hours, Hide Permanently, and Manage Hidden Values are
not available for Geomap charts.

Note: When you edit a value in a preconfigured dashboard, it is a user-specific change. The
changes made to a preconfigured dashboard will be applicable only to your dashboard and
cannot be viewed by other users who use the same preconfigured dashboard. For example, if
you hide a value in an overview dashboard, the change will be applicable only to your
dashboard. If another user views the same overview dashboard, the value will still be
displayed. The same applies to a custom dashboard. When you hide a value in the custom
dashboard and share the same dashboard with another user, the values will still be displayed
even though the dashboard is shared.

For more information on available dashlets, see the Dashboards Catalog in the RSA Content
space on RSA Link.
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Rearrange a Dashlet

You can arrange dashlets according to your preference by dragging and dropping them into a
different order on the dashboard.

1. To move a dashlet, hover in the header of the dashlet that you want to move.
The directional cursor ¥ appears over the dashlet. Click and hold in the header of the
dashlet that you want to move.

2. Continue to hold the left mouse button and drag the window toward the new location.

The figure below shows a dashlet as it is being re-arranged.

3. Release the mouse button when the dashlet is in the desired location.

The dashlet that currently occupies that position moves down.

Maximize a Single Dashlet

This section explains how to open a dashlet on the entire area of the main NetWitness
Suitedashboard with the same dashlet title. Dashlets that have a lot of columns or charts, for
example some Reporting dashlets, are easier to view when maximized so that the entire contents
is visible without scrolling.

To maximize a dashlet, click the maximize control icon in the dashlet title bar: " The dashlet is

displayed on full screen.

To minimize a dashlet, click the same control icon in the dashlet title bar: " The dashlet is

restored to previous size.
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Delete a Dashlet

1. Click * in the dashlet title bar:

A confirmation pop-up is displayed to confirm if you want to delete the dashlet.

2. Click Yes, if you want to delete. The dashlet is removed from the dashboard.
Click No, if you do not want to delete.

Note: After you remove the dashlet, the empty space is replaced by a placeholder where you
can add another dashlet using the above Add a Dashlet procedure.

Importing and Exporting Dashboards

The ability to customize dashboards to changing circumstances and conditions could result in a
large number of dashboards that are not needed on a daily basis. Rather than reinvent the wheel
each time you want to recreate a particular custom dashboard, you can export your dashboards
that are not currently in use. When you are ready to use a previously exported dashboard, import
the dashboard into NetWitness Suite.

Import a Dashboard

Note: You can import the Reporter Realtime Charts dashboard and its related charts in
different instances of the NetWitness Suite server and Reporting Engine from which it was
exported.

1. In the dashboard toolbar, select Import Dashboard B
The Import Dashboard dialog is displayed.
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2. Browse to the dashboard file in the Import Dashboard dialog. You can import .cfg and .zip
files.

3. Click Import Dashboard.
The dashboard is displayed in NetWitness Suite

Note: If you import a dashboard from Security Analytics 10.6. x into NetWitness Suite11.0,
the dashboard and the associated rules and charts must be imported separately. But when you
import a dashboard from NetWitness Suite11.0 into NetWitness Suite, the dashboard and all
the rules and charts associated with it, gets imported in .zip format.

Export a Dashboard

Exported dashboards are designed to work within the same NetWitness Suite instance. It is also
possible to share your custom dashboards with other users in your organization, provided
they have equivalent permissions.

To export a dashboard, you must have the dashboard open to access the Export Dashboard option
under the Edit drop-down menu in the dashboard toolbar.

1. Navigate to the dashboard that you want to export. All existing dashboards appear in the
drop-down Dashboard Selection List in the currently displayed dashboard.

2. Click Export Dashboard (!) in the dashboard toolbar.

The exported file is saved in the .zip format.

Note: The Export feature is not applicable for preconfigured dashboards.

Copying a Dashboard

To customize the views in NetWitness Suite, you can copy dashboards to the NetWitness
dashboard or a custom dashboard. The NetWitness Suite dashboard, as the name suggests, offers
all NetWitness Suite dashlets. The Copy Dashboard dialog creates a duplicate dashboard, which
can be customized. When you copy a dashboard, the default name will be prefixed with Copy of.
For example, if the name of the original dashboard is XYZ, the default title of the copied
dashboard will be Copy of XYZ.

To copy a dashboard:
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1. Navigate to any dashboard

2. In the dashboard toolbar, click .

The Copy Dashboard - Default dialog is displayed. The following screenshot is an example
of copying a dashboard.

Copy Dashboard - Default

Dashboard Title Copy of Default

3. Enter the Dashboard Title.
4. Click Copy.

Sharing a Dashboard

In NetWitness Suite, as an Administrator you can share dashboards for viewing purposes with
other roles such as Administrators, Analysts, Operators and so on. When you share a dashlet,
the users can only view the dashboard, make dashboard as favorite, copy the dashboard, and
export the dashboard. In case of other roles such as Analysts, Operators and so on, you can
share the dashboard only with similar roles. For example, an analyst will be able to share a
dashboard with other analysts only.

1. Navigate to any dashboard.

2. In the dashboard toolbar, click and select the checkbox of the role with whom
you want to share the dashboard.

Note: If you do not want to share the dashboard, clear the checkbox of the role.
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Managing Jobs

Inevitably, there are tasks, on-demand or scheduled, in NetWitness Suite that take a few minutes
to be completed. The NetWitness Suite jobs system lets you begin a long-running task and
continue using other parts of NetWitness Suite while the job is running. Not only can you
monitor the progress of the task, but you can also receive notifications when the task has
completed and whether the result was a success or failure.

While you are working in NetWitness Suite, you can open a quick view of your jobs from the
NetWitness Suite toolbar. You can look anytime, but when a job status has changed, the Jobs

icon (ﬂ) is flagged with the number of running jobs. Once all jobs are completed, that number
disappears.

You can also see the jobs in these two views.

o In the Profile view, you see the same jobs in a full panel. These are only your jobs.

o Inthe System view, users with administrative privileges can view and manage all jobs for all

users in a single jobs panel.

The structure of the jobs panel is the same in all views.

Display the Jobs Tray

In the NetWitness Suite toolbar, click the Jobs icon: ISl

The Jobs Tray is displayed.
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The Jobs Tray lists all jobs that you own, recurring and non-recurring, using a subset of the
columns available in the Jobs panel. Otherwise the Jobs Tray and the Profile view > Jobs panel
are the same. In the Administration System view, the Jobs panel lists information about all
NetWitness Suite jobs for all users.

View Your Jobs in the Profile View > Jobs Panel

To see a larger view of your jobs, click View Your Jobs.
The Profile view > Jobs panel is displayed.
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Pause and Resume Scheduled Execution of a Recurring Job

The Pause and Resume options apply only to recurring jobs. You can pause a recurring job that
is running; however, it has no effect on that execution. The next execution (assuming the job is
still paused) is skipped.

1. To stop the next execution of a recurring job, in any Jobs panel, select the job, and click
Pause.

The next execution of the job is skipped, and the schedule is paused until you click Resume.
2. To restart execution of paused recurring jobs, select the job and click Resume.

The next execution of the job occurs as scheduled, and the schedule for the job resumes.

Cancel a Job

To cancel jobs that are executing or in the queue to execute:
1. Inthe Jobs Tray or either Jobs panel, select one or more jobs.
2. Click Cancel.
A confirmation dialog is displayed.
3. Click Yes.
The jobs are canceled, and the entries remain in the grid with a status of canceled.

If you cancel a recurring job, it cancels that execution of the job. The next time the job is
scheduled to run, it executes normally.

Delete a Job

Caution: When you delete a job, the job is instantly deleted from the grid. No confirmation
dialog is offered. If you delete a recurring job, all future executions are removed as well.

Users can delete their own jobs before, during, or after execution. Users with the ADMIN role
can delete any job. To delete jobs:

1. Select one or more jobs.
2. Click Delete.

3. The jobs are deleted from the grid.
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Download a Job

When a job has the Download status in the Action column, you can download the result of the
job. If you are working in the Investigation Module and extract the packet data for a session as a
PCAP file or extract the payload files (for example, Word documents and images) from a
session, a file is created. To download the file to your local system, click Download.
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Viewing and Deleting Notifications

While you are working in NetWitness Suite, you can view recent system notifications without
leaving the module in which you are working. You can open a quick view of notifications from
the NetWitness Suite toolbar. You can look anytime, but when a new notification is received,
the Notifications icon is flagged.

Examples of notifications include:

o A host upgrade completed.
o A parser push to decoders completed.

o A newer software version is available.

You can see all notifications in a full Notifications panel in these two views.

o In the Profile view, you see only your notifications.

o Inthe System view, users with administrative privileges can view and manage all

notifications for all users in a single panel.

View Notifications

To display the Notifications tray, click the Notifications icon ( ).

View All Notifications

To view all notifications, do one of the following:
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1. Go to Profile, then in the options panel of the Profile view, select Notifications.

2. Goto ADMIN > SYSTEM, then in the options panel of the System view,
select Notifications.
3. Click I8 o open the Notifications tray, then click View All in the Notifications tray.

The Notifications panel is displayed. Here all notifications are displayed, and the format is
different from the format of the Notifications Tray.

Delete Notification Records

To delete notification records:

1. In the Profile Notifications table, select the notifications that you want to delete.
2. Click =.

The selected notifications are deleted from this table and from the Notifications Tray.
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Viewing Help in the Application

There are different ways available to get help while using NetWitness Suite.Y ou can use inline
help, tooltips, and online help links.

View Inline Help

Inline help provides additional information about what to do in sections or fields that you are

currently viewing in the NetWitness Suite user interface. To display inline help, hover over ® .
The inline help shows a brief description of the element.

Inline help example:

View Tooltips

Tooltips are a quick way for you to see a description of the text or additional information about
an action, field, or parameter. Tooltips appear as underlined text. To display the tooltip and see a
brief description of the term, hover over the underlined text.

Tooltip example:

View Online Help

Online help links take you outside of NetWitness Suite to the RSA Link online documentation.
This site has a complete documentation set for NetWitness Suite, and the links take you directly
to the topic that describes the part of the user interface currently in view.

To view the online help topic for the current location, click in the NetWitness Suite toobar
or in a dialog. The relevant help topic is displayed in a separate browser window. The topic
describes the features and functions of the current view or dialog. From that topic, you can
quickly navigate to the related procedures.

The following figure is an example of the online help icon in the NetWitness Suite toobar.
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Finding Documents on RSA Link

The RSA NetWitness® Suite documentation is located on RSA Link, the RSA support portal
and community. RSA Link brings all of your RSA resources together in one place. It includes

advisories, product documentation, knowledge base articles, downloads, and training. To view a

Guided Tour of RSA Link, see https://community.rsa.com/videos/21554.

Locate NetWitness Suite Documentation

NetWitness Suite Logs and Packets documentation is at the following link:
https://community.rsa.com/docs/DOC-40370

To navigate to NetWitness Suite Logs and Packets documentation:

1. Onthe RSA Link homepage (https://community.rsa.com), click RSA NETWITNESS
SUITE.

2. On the RSA NetWitness Suite page, click DOCUMENTATION and select RSA
NETWITNESS LOGS AND PACKETS.

To navigate to NetWitness Endpoint documentation:

1. On the RSA Link homepage (https://community.rsa.com), click RSA NETWITNESS
SUITE.

2. On the RSA NetWitness Suite page, click DOCUMENTATION and select RSA
NETWITNESS ENDPOINT.

Locate RSA Content

RSA Content is at the following link:
https://community.rsa.com/community/products/netwitness/rsa-content

To navigate to RSA Content:

1. On the RSA Link homepage (https://community.rsa.com), click RSA NETWITNESS
SUITE.

2. On the RSA NetWitness Suite page, click DOCUMENTATION and select
ADDITIONAL RESOURCES > RSA CONTENT.

Finding Documents on RSA Link
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Locate RSA Supported Event Sources

RSA Supported Event Sources are at the following link:
https://community.rsa.com/community/products/netwitness/parser-network/event-sources

To navigate to RSA Supported Event Sources:

1. On the RSA Link homepage (https://community.rsa.com), click RSA NETWITNESS
SUITE.

2. On the RSA NetWitness Suite page, click DOCUMENTATION and select
ADDITIONAL RESOURCES > EVENT SOURCE CONFIGURATION.

Locate Hardware Setup Guides

The Hardware Setup Guides are at the following link:
https://community.rsa.com/community/products/netwitness/hardware-setup-guides

1. Onthe RSA Link homepage (https://community.rsa.com), click RSA NETWITNESS
SUITE.

2. On the RSA NetWitness Suite page, click DOCUMENTATION and select
ADDITIONAL RESOURCES > HARDWARE SETUP GUIDES..

Find Documents Using NetWitness Navigator

You can search for desired RSA NetWitness Suite documentation in RSA Link using the
NetWitness Navigator tool.

1. Onthe RSA Link homepage (https://community.rsa.com), click RSA NETWITNESS
SUITE.

2. Under PRODUCT RESOURCES (right side of page) click RSA NetWitness Navigator.

3. Select desired search criteria from the available options. When searching for documentation,
you should select User Documentation as the Content Type. Also, the Cost option is

ignored for user documentation.
4. Click VIEW RESULTS to view a list of matching documents.

5. Click RESET OPTIONS to clear your previous search options.

Follow Content for Updates

You can follow pages or documents to be notified of changes.
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1. Loginto RSA Link.
2. Navigate to a page or a document and in the top right corner select either Follow or Actions

> Follow.

Send Your Feedback to RSA

Your feedback is very important to us and helps us to provide a better experience for our
customers. Please send your suggestions to sahelpfeedback@rsa.com.
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NetWitness Suite Getting Started References

The following section contains user interface reference information related to getting started
with the NetWitness Suite application.

e User Preferences

e Notifications Panel and Notifications Tray

e Jobs Panel and Jobs Tray
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User Preferences

To adjust NetWitness Suite to best fit your environment and work practices, you can set your
own global application preferences. You can:

o Set your language and time zone

o Set the date and time formats (Respond view only)

o Select your default starting location (Respond view only)

o Change your password

« Enable notifications

o Enable context menus

o Change Investigate preferences - Described in the Investigation and Malware Analysis User

Guide.

Your global preference options vary depending on whether you access them from the Respond
view or other views, such as Investigate, Monitor, Configure, and Admin.

What do you want to do?

All Change my Password Change My Password
All Choose my Default Landing Page Setting up Your Default View
by SOC Role
All Set my User Preferences Setting User Preferences
Related Topics

o NetWitness Suite Basic Navigation

User Preferences (Respond view)

To access your user preferences, click @
The User Preferences dialog shows your current preferences and the NetWitness Suite version.
The main menu bar shows the current time zone preference next to the user profile icon.
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The following table describes the global application preference options that you can access from
the Respond view.

O T

Time Zone Sets the time zone to use in NetWitness Suite.

Date Format Sets the format for the order of the display of the month (MM), day
(DD), and year (YYYY). For example, the MM/DD/YYYY format
shows the date as 05/11/2017.

Time Format Sets the time as 12-hour or 24-hour time. For example, 2:00 PM in

12-hour time is 14:00 in 24-hour time.

Default Landing Page  Enables you to select the default view when you log in to
NetWitness Suite. You can choose Respond, Investigate, Monitor,
Configure, and Admin according to your user role. For example, you
can choose Respond to go directly to the relevant section of the
application for Incident Responders.

This selection sets the default view for the entire application.
Change my password  Opens the Preferences dialog where you can change your password.

Version Shows the NetWitness Suite version.

Sign Out Enables you to log out of NetWitness Suite.
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Any selections that you make become effective immediately.

Preferences
To access your user preferences, do one of the following:

o For most views, such as Investigate, Monitor, Configure, or Admin, go to @ > profile.

o Inthe Respond view, select B 2nd in the User Preferences dialog click Change my

password

The Preferences dialog shows your current preferences.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN E:@]admin
I Preferences Preferences
Notifications General Investigation
Jobs
Change My Password o
Password Format Requirement
0ld Password = Must be at least 8 characters

New Password

Confirm Password

Reset Password After you change your password, you will have to log back into NetWitness,

Application Settings
Browser Time Zone UTC (GMT+00:00) hd

[+ Enable Notifications
[ Show Context Menus

Apply

| NETWITNESS SUITE 11.0.0.0-170

The following tables describe the global application preference options that you can access from
these views.

Change My Password

This section enables you to change your password. Your Administrator defines the appropriate
password strength requirements for your NetWitness Suite password, such as minimum
password length and minimum number of uppercase, lowercase, decimal, non-Latin alphabetic,
and special characters. These requirements are then displayed when changing your password.

The following tables describes the options in the Change My Password section.

N

Old Password Enter the password that you used to log in to NetWitness Suite.
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G =

New Password Enter the password that you want to use for the next login.
Confirm Password Retype the new password.
Reset Password Updates your user profile with the new password. You will be

logged out of NetWitness Suite for the changes to take effect. The
new password becomes effective the next time you log in to
NetWitness Suite. The password change is applied to your system
login and to all NetWitness Suite services on which your account
has been added.

If you changed your password, you will be logged out of NetWitness Suite for the changes to
take effect. The new password becomes effective the next time you log in to NetWitness Suite.

Application Settings

The following tables describes the options in the Application Settings section.

N

Browser Time Zone Sets the time zone to use in NetWitness Suite. Y our time zone

preference is displayed on the toolbar.

Enable Notifications This checkbox enables and disables notifications for your user
account. By default, NetWitness Suite system notifications are

enabled when a new user account is created.

Enable Context Menus  This checkbox enables and disables context menus for your user
account. By default, context menus are enabled when a new user
account is created. Context menus provide additional functions for

specific views when you right-click in a view.

Apply Updates your preferences and applies the changes immediately.

Notifications Panel and Notifications Tray

NetWitness Suite provides system notifications to advise users about certain actions or
conditions.
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A host upgrade completed.

A parser push to decoders completed.

A service went down (critical log of a certain type).
o A visualization completed.

A report completed.

o A newer software version is available.

While you are working in NetWitness Suite, you can view recent system notifications without
leaving the module in which you are working. You can open a quick view of notifications from
the NetWitness Suite toolbar. You can look anytime, but when a new notification is received,
the Notifications icon is flagged.

When you are viewing notifications in the Notifications tray, only recent notifications are
displayed. You can view all notifications in a table format in the Profile view or in the System
view. Procedures for viewing notifications are provided in Viewing and Deleting Notifications.

What do you want to do?

All View all notifications Viewing and Deleting
Notifications

All Delete notifications Viewing and Deleting
Notifications

To access the Notifications panel, do one of the following:

« Go to Profile, then in the options panel of the Profile view, select Notifications.
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o Goto ADMIN > SYSTEM, then in the options panel of the System view,

select Notifications.

o Click , then click View All in the Notifications tray.

The Notifications panel and tray has a toolbar and a table. The Notification tray is a subset of
the information in the Notifications panel. The following table describes the Notifications panel
features.
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e

= Displays a drop-down menu where you can delete the selected notification records

or all the notification records in the Notifications table and in the Notifications

Tray.
Title The title of the notification, for example, File Extraction Complete.

Message The entire message, for example, The file extraction is complete and ready for

download.

View Some messages include a link that displays a view where you can take action. For
example, if there is a file to download, clicking this link opens the Jobs panel, the

view where you can download the file.

Created The date and time the notification was created.

In the Notifications Tray, this column is the number of days since the notification

was created.

View All Displays the Profile View Notifications table.

Jobs Panel and Jobs Tray

Jobs are started by various NetWitness Suite modules; for example, the Live module can
download CMS resources, the Administration module can upload a feed to a service, and the
Investigation module can analyze and reconstruct packets in packet capture files.

In the Administration System view, users in the ADMIN group can manage all NetWitness Suite
jobs in the Jobs panel. Other non-administrative users can view their own jobs in the Profile
view.

In addition, while working in NetWitness Suite, you can open a quick view of your jobs from the

NetWitness Suite toolbar. When a job status has changed, the Jobs icon (E) is flagged with the
number of running jobs. Once all jobs are completed, that number disappears.

In the Jobs panel, you can:

o View and sort the jobs
o Pause or resume a job

o Cancel a job
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o Delete a job

o Download a job

The structure of the jobs panel is the same in all views.

What do you want to do?

All Pause and Resume a Scheduled Job Managing Jobs
All Cancel or Delete a Job Managing Jobs
Download a Job Managing Jobs

To access the Jobs panel, do one of the following:

o« Goto ADMIN >SYSTEM, and in the options panel, select Jobs.
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« Go to Profile, and in the options panel, select Jobs.

The Jobs panel organizes information about jobs into a grid. The columns present a job progress
bar, the job name, an indication that the job is recurring or not recurring, the NetWitness Suite
module that is controlling the job, the owner of the job, the status, any associated message, and a
download button to allow downloading of a job's packet capture files or payload files.

P

To display the Jobs tray, click the Jobs icon K.

The Jobs tray lists all jobs that you own, recurring and non-recurring, using a subset of the
columns available in the Jobs panel. Otherwise the Jobs tray and the Profile View > Jobs panel
are the same. In the Administration System view, the Jobs panel lists information about all
NetWitness Suite jobs for all users.

The following table describes the options in the Jobs panel.
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e

' Resu The Resume option applies only to recurring jobs that have been paused. When
you resume a paused job, the next execution of the job executes as scheduled.
The Pause option applies only to recurring jobs. When you pause a recurring job
o
||

fm

Paus (hat is running, it has no effect on that execution. The next execution (assuming the

job is still paused) is skipped.

Cancels a recurring or non-recurring job. You can cancel a job while it is running.
Cancel 1fyou cancel a recurring job, it cancels that execution of the job. The next time the

job is scheduled to run, it executes normally.

Deletes a recurring or non-recurring job from the Jobs panel. When you delete a
job, the job is instantly deleted from the Jobs panel. No confirmation dialog is

offered. If you delete a recurring job, all future executions are removed as well.

The following table describes the Jobs tray and Jobs panel features.

e e

Selection S )
Click in this box to select one or more jobs.

box

Progress Shows the percentage complete for a job.

Job Name Displays the name of the job; for example, Extract Files or Upgrade Service.

Indicates whether the job is recurring or non-recurring. Yes = recurring, No =

Recurring )
non-recurring.
Indicates the component in which the job originated; for example, Investigation
Component
or Administration.
Indicates the owner of the job. The owner of the job is not included in the default
Owner Jobs Tray, because only the current user's jobs are displayed here. The column
is available to add.
77 NetWitness Suite Getting Started References



Getting Started Guide

e

Indicates the status of the job. Common values for status are Paused, Running,

Status
Canceled, Failed, Completed, and other status values are possible.
Displays additional information about the job; for example, Extracting files or
Message
No sessions found.
Views job in the Investigation Malware Analysis view, or downloads job files
e for the job to the default Downloads directory on the local system. Only
ction
successfully completed jobs have the View link in the Action column. Only jobs
that create a file have the Download link in the Action column.
View Your _
. Displays jobs in the Profile View > Jobs panel.
Jobs

Scheduled Indicates the date and time at which the job was scheduled to begin.
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